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Introduction
WinGO! is a version of the game played in Bingo halls around the world.    In WinGO! it's you
against Rosie, a dead-eyed Bingo veteran that hates to lose.    At her expert level, you'll 
need your best concentration and all the luck in the world to win.    WinGO! includes all of 
the features you will find in any Bingo hall.    Items such as a scoreboard, a number caller, 
and the playing cards are all here.    However, there are a few twists to make this version of 
the game more suitable for a one-on-one game played on a computer.

A conventional Bingo game consists of a series of games with different goals in place to 
determine a winner. This means that to win, you must have a card that matches some of 
the called numbers in a set pattern, such as a row or column of numbers.    There is no 
standard Bingo game series.    Of all of the Bingo halls I've been in, no two used the same 
method.    So, WinGO! has a series of games that are probably unique to this computer 
version.    You can play all of them, or some of them.    In addition, you may load other game
sets that provide different games for you to play.    The registered version allows you to 
design your own set, so you can make WinGO!    play just like the games that you are used 
to playing.

Most people already know how to play this game.    These instructions are mainly to show 
you how to use the controls in this version.    Many of the controls are configurable, and 
once you learn what they are and how to use them, you will be able to focus on the real 
meaning of WinGO!, namely, beating Rosie!



Playing WinGO!

Once you start the program, you will see a screen containing the window above.    This is the 
Playboard.    It contains many items.    You can find out what each section of the PlayBoard is 
used for by clicking on them with your mouse.

Playing Cards

Just as in Bingo, most of a player's attention is focused on the cards they have in front of 
them.    The same idea applies to WinGO!, but you do not have to worry about a dabber or 
chips to mark your numbers.    Just click on the number as it is called.    If you click on the 
wrong number, just click on it again, and it will be restored.    There are two marker types 
available.    The number can be blanked (erased) when you click on it, or it can be grayed.    
This option is configured in the Game Setup dialog.    

Since there are so many numbers to deal with, and because everyone's eyes work 
differently, WinGO! provides several options for seeing the Playing Cards.    First, you can 
choose the number of cards to play with.    The maximum is about 11 cards due to system 
resource limitations.    This may be greater on systems with more than 8Mbytes of RAM.    
However, 11 cards should be difficult enough for almost any player.    The second option 
you may configure is the color of the numbers shown on the card.    This can make a big 
difference for many players.    Finally, you can select the size of the card from among three 
sizes.    You should try different combinations of these options to find the setup that suits 
you best.    Note that the first option is available from the Game Setup dialog, while the 
others are found in the Option menu.





Game Setup

This dialog is used to control some of the major options of WinGO! game play.    In particular, 
these are options which cannot be changed once you start a game.    You access this dialog 
by selecting the first item in the Options Menu.

Once you have opened this dialog, you will see the window shown above.    The group of 
checkboxes on the left indicate to WinGO! which types of games you would like to play.    
They are played in order from top to bottom as shown.

On the right is an editbox in which you can type the number of cards to use while playing.    
The actual number you will get depends on the size card you have selected (from the 
Options Menu) and the size of your screen.

Below this are two other option groups.    The first allows you to select the type of card 
covers to use.    Card Covers are computerized versions of a dabber or chip used in standard 
Bingo games to indicate which numbers on your card have been called.    You have a choice 
here to Blank Out the number when you click on it or to Gray Out the number so you can still
read it.

The other option group is the Skill Level you would like Rosie to play at.    If you select 
Beginner level, she will play like a human, making occasional mistakes.    At Novice level 
she makes rare mistakes, and if you select Expert, she plays like a computer (which she 
is!).

To put the setup changes you have made into effect, press the Ok button.    To return to 
WinGO! with the program setup as it was when you opened the Game Setup dialog, press 
the Cancel button.



Registration
WinGO!    is Copyright 1993, 1994, 1995 by Bob Dolan, All rights reserved.

If you have already registered and would like to validate your copy of WinGO!, open the 
Register menu and select the Enter Registration Number item.    Enter the number that 
was provided in your registration letter.    The OK button will become enabled, and you can 
press it.    When the dialog closes, the program becomes a registered version.    You will no 
longer see registration reminders.    Thank You for your support!

Otherwise...

WinGO! is distributed as Shareware.    This means that if you regularly use the product and 
benefit from it, you should register with the author (see name and address below).    The 
software you now have is not crippled in any way.    This indicates a basic trust of the 
Shareware concept by myself and other Shareware authors who provide useful products 
with the hope of some type of return for their efforts.

The basic registration cost of this product is $15.

Please print the registration form and fill in the requested information.    In addition you may
register by credit card.

You may contact me electronically in the following ways:

GEnie: DOLAN
Compuserve: 71075,3256
Internet: 71075,3256@compuserve.com

Distribution

If you distribute WinGO!      to friends, associates, or to a computer bulletin board system 
(BBS),    you may only distribute the compressed file including the copyright and disclaimer.

Disclaimer

The Copyright Owner hereby disclaims all warranties relating to this software, whether 
express or implied, including without limitation any implied warranties of merchantability or
fitness for a particular purpose. The Copyright Owner will not be liable for any special, 
incidental, consequential, indirect or similar damages due to loss of data or any other 
reason, even if The Copyright owner or an agent of The Copyright Owner has been advised 
of the possibility of such damages.    In no event shall The Copyright Owner's liability for 
any damages ever exceed the price paid for the license to use the software, regardless of 
the form of the claim. The person using the software bears all risk as to the quality and 
performance of the software.



Update History
Version 2.0 June 1995

Rebuilt sound handling using the FastWave library to play WAV files from memory.
Game Groups can now be loaded.    The registered version allows users to design and 

share their own games.
High Scores are now shown in a separate dialog and are kept in a separate file.
The hint picture is now animated and shows all winning patterns.

Version 1.3 -- Feb 1994
Changed startup sequence.

Version 1.2 -- September 1993
First Registered release, multimedia version.

Version 1.00 --June 1993
First Shareware release.



The File Menu

The File Menu is where you Control the game play and access other files.

The New Game item does what it says.    You select this item to start a new game.    Once a 
game begins, this item becomes grayed out (disabled) and the Stop Game menu item 
becomes enabled.

The next item is the Stop Game item and is not available unless you are currently playing a 
game.    When you select this item, you will be prompted for confirmation before the game is 
stopped.

After this is the Load Game Group menu item.    Selecting this brings up a file selector, 
allowing you to choose from other WinGO! games that you can play.    The shareware version
of WinGO! comes with the Classic game as well as an interesting Alphabet series.

Then there is the Show High Scores item.    When you select this, a window will be displayed 
showing all of the high scores for each of the games in the current game group.

Finally, the Exit menu item will get you out of this and back to work (or to sleep)!



The Options Menu

WinGO! has been designed to be very configurable.    All of these adjustments can be found 
in the Options Menu.    The first item is the Game Setup.    This opens a dialog that allows you
to configure items that cannot be changed once a game has started.    Because of this, the 
Game Setup menu item is grayed out once you start a game and re-enabled when it ends.

After this is the Expert Mode control.    Before each game type begins, a short description of 
how to get a winning combination is displayed.    Once you know how the games work, these 
reminders may become annoying.    Select this menu item and make sure it is checked to 
keep these messages from coming up.

The next menu item is the Sound control.    The new functionality of this menu item is 
described in the New Features section.

WinGO! runs at three speeds.    To select which speed to play at, click on the Speed item. 
Another menu will pop up next to it, allowing you to select the new game speed.    The 
current speed has a checkmark next to it.    The Slow speed updates the current number 
every 7 seconds.    Medium speed updates at 5 seconds, and Fast at 3 seconds.    If you find 
Fast to be too slow, then add more playing cards.

The next menu item, Card Size,    controls the size of the playing cards.    Depending on the 
resolution of your screen, you may need to make cards smaller to get more of them to 
display.    WinGO! will not give you cards that do not fit on the screen completely.    At 800 
by 600 resolution you can play 11 small, 10 standard, or 4 large cards.    Your mileage may 
vary.

If you change card sizes during a game, you may lose cards!    It is best to make this type of
change between games, before you press the Start button.    However, you will probably 
find that you settle on a game setup that suits you best and stick with it.    WinGO! always 
saves the latest changes you make to your setup, so they are there when you run it next.

The last menu item in the Options menu is used to change the Playing Card text Colors 
between Red, Blue and Black.    This popup works just like those previously described.



High Scores

This is the High Scores Dialog.    To find out what each of the controls does, just click on 
them.



Registration Form
To print this registration form, open the File menu and select Print Topic.

Mail to:
Bob Dolan
P. O. Box 16514
Rochester, New York 14616-0514

Register me as a satisfied user of WinGO! (ver 2.0):

Please enclose $15 in US funds.    Make checks or money orders out to Bob Dolan.    

Your registration includes a disk containing the latest version of WinGO!, along with a bunch
of extras (click here to see a list!).    In addition, this disk will include evaluation copies of 
many of my other products.    These will be the current versions of each, including programs
that were not available when this was written.    The disk will be a 1.4M 3.5 floppy unless 
you request otherwise.    All files will be in ZIP 2.04g format unless you request otherwise.

For orders from outside of the U.S., please add $3 to cover additional postage.

Can you UNZIP files?    Yes________    No________

Name:_____________________________________________________

Address:___________________________________________________

City:______________________State:_______Zip:__________________

Phone(optional):_____________________________________________

GEnie/CompuServe/Internet mail address:_______________________

Where did you get this program?    This is important in that it helps us to distribute the 
product to places where you are more likely to see it.
__________________________________________________________

___________________________________________________________

Comments:_________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________



Other Products from Bob Dolan Software

Windows Shareware

WRackO -- A number strategy game that is easy and fun

WRackO is a challenging, card type strategy game that you can play against the computer 
or another person.    It is easy to learn, simple to master.    Quick thinking and risk taking are
essential to being a winner in WRackO.

The Spelling Voice -- A learning program that makes spelling fun!

An educational program that is both fun and effective.    Students create and use spelling 
lists that are spoken to them in their own voice.    An easy to use interface guides spellers 
from the age of 5 to 50 in improving their spelling skills.    This program requires a sound 
card for proper usage.    A microphone is also suggested.

DeskMenu! --    A low profile, text based Program Manager for Windows

There is probably no other program you can add to your system that will make better use 
of its screen and disk space than DeskMenu!    This easily configured program manager and 
resource monitor speeds access to all your applications.    DeskMenu! places a menubar on 
your desktop and allows you to setup the menu headings to reflect how you categorize 
your applications. An optional InfoBar shows time, date and up to six different system 
resources. DeskMenu! can be used in addition to the Program Manager or it can replace it 
as the Windows shell.    All of this functionality in a good looking, easy to use package!

Yacht-Z    --    A dice strategy game for Windows

Yacht-Z is a version of the classic dice game.    You can play single or triple scoring varieties 
of the game.    Up to four players can play at once. This is the original and most often 
reviewed of all Yacht-Z type dice games.    Several years of constant use and valuable input 
from users has honed this into one of the most enjoyable and challenging games available (
unless you prefer blowing up things! ).

WinGo! --    The classic Bingo for Windows

Finally, Bingo has arrived for Windows!    You match wits with Rosie, an alert and cunning 
adversary.    You can play with as many cards as you can handle at the speed you like.    
Fully configurable to adapt to your playing style.    The registered version includes digitized 
voice calling for the most realistic Bingo play possible.

The Joker -- Jokes On Demand

The Joker gives you a laugh whenever you need it. Just as your day is getting completely 
boring, a window will appear with a joke to break the ice.    If one joke doesn't do it for you, 
then press the ANOTHER button for more.    The program is easy to use, and once setup to 



your liking, it will require no maintenance.    You can load different joke files, order more 
from the author, and even create your own.

BattleGrid -- War in a window -- Battleship for Windows 3.x

BattleGrid is a version of the classic board game.    Play against the computer or another 
person.    Watch the computer play against itself using different strategies.    Several levels 
of a computer opponent are available, from idiot to genius.    

SCAT -- A strategic and daring card game

Don't get stuck with the lowest hand!    SCAT is a card game involving four players that can 
be as simple or challenging as you want.    Features include defining strategy levels, setting 
the game speed, and leaving the cards face up or face down as you play.    This game even 
includes conversational chit chat between the players!    Very addicting and fun!

WinDial -- A    Windows Phone Book that dials

An easy to use phone book that will automatically dial any selected number as long as you 
have a modem.    When a busy signal is detected, you can tell WinDial to retry until 
someone answers.    Other busy attempts can be placed into a queue, and all will be retried 
in order.

Mister Clean -- Clean up your hard drive

One of the most efficient ways to clean up those hidden but unwanted or unused files that 
take up needed space.    A slick Windows 3.x user interface makes this utility a must have 
for your toolbox.    Mister Clean finds files the you specify and sorts them by size.    You click 
on the ones you want deleted and then off they go, one-by-one (to be safe) or all at once.    
Not sure what the file is?    Then run it right from Mister Clean and check it out before 
dumping it!    Truly a unique way of managing precious disk space.

InstallWare -- An application installer
InstallWare is a small, easy to use application installation program for Windows 
applications.    It costs nothing to use if you are distributing Freeware.    Registration 
provides an extended version that enables automated construction of installation disks.

Windows Freeware
16 Tons -- Drop your sound files here!
Simply plays WAV and MIDI files.    Accepts drag & drop operations from the file manager.    
Most handy when used it as an icon.

Random Saver -- Variety in savers
Make full use of that collection of screen savers you've got.    Now you can get them out of 
your WINDOWS directory.    This utility will run them at random from any location when you 
install it as the default screen saver in the Windows Control Panel.





Other Features
Opening Screen Bypass    If the title screen that displays when you start WinGO! 
becomes tiresome, you can pass a command flag that will bypass it.    To do this, go to the 
Program Manager and click once on the WinGO! icon to highlight it.    Then select the 
Properties item in the File menu.    This will bring up the Program Item Properties dialog.    
The second line of this window contains the command line used to start the program.    Just 
add a space and the letter F to the end of this command line.    If you used the default 
installation, it would look like the following: C:\WINGO\WINGO.EXE F

Sound Control Dialog    With the addition of real sound capabilities to this version of 
WinGO!, the degree of control is also greater.    Using the Sound Control Dialog box, you can
determine whether to use the beep sound from the unregistered version, the voice calling 
feature that is new in this version, or no sound at all.    Make your selection by clicking on 
the appropriate radio button in this dialog.    Note that this controls only the sound effects 
during the number calling.    All other sounds will always be enabled as long as you have a 
working sound card.
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Why Register?
Why should you register this product?    What's in it for you?    The topics listed below have 
more information on this questions

The reasoning
What you receive
Registering WinGO!



Credit Card Payment
The basic registration cost of this product is $15.

We now have a new credit card payment option available.    This is accessible through a toll-
free phone line.    In addition, you can access this service by mail, CompuServe or Fax.    
Payments made through this channel are subject to a $5.00 handling fee.    As always, you 
can register by check or money order through our PO Box.    This new service has been 
added to accomodate the needs of some of our customers.    We hope you find this helpful 
and convenient.

You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling:
1-800-2424-PsL 
713-524-6394 
between the hours of    7AM to 6PM CST (Monday-Thursday) and 7AM to 12:30PM CST 
(Friday)

Be sure to mention that you are registering Product Number 11815

By FAX to 713-524-6398

By CIS Email to 71355,470. 

You can mail credit card orders to:
PsL
at P.O.Box 35705, Houston, TX 77235-5705.

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.



Reasoning
Why should you register a Shareware product?    Since you already have the product, why 
should you pay for it?    The fact that many people using Shareware feel this way has a lot 
to do with the trend towards crippling and nagging.    Shareware authors are trying to 
create incentive for those who use their products to actually pay for them.    In a perfect 
world, those who try Shareware realize that they only have a license to evaluate the 
product, and after a reasonable amount of time, will either pay for the right to continue 
using it, or remove it from their computer.

It isn't always a question of affordability.    I know folks with more money than you could 
imagine that would never pay for a Shareware package ("it's free software, isn't it?").    On 
the other hand, I know of people that barely make their bills each month that wouldn't think
of using a Shareware product that they hadn't registered.

The only difference between this software and the software you buy at the store, is that 
shareware gives you the benefit of making sure that the product is of value to you.    If you 
are still using it after two weeks, then you should should consider registering.    Not doing so
is no different than stealing a software package from your local computer store.

So much for the ethics of registering Shareware.    Understandably, some folks just aren't 
interested in this.    Even though it all makes sense, what they really want to know is: What 
do I get when I register? 



What You Get
This is what you get when you register one of my products:

The ethics angle is covered.    You have done the Right Thing.
Any nagging that is going on will stop.
If there are features missing, they will be enabled.
I will send you a disk with many of my other products for you to evaluate.
You will get the latest version of the program that you are registering.
If you find a newer version later on, the registration number I send you will register 

that also.
If you need to call me for help, you will have my undivided attention.
Some programs offer extras to make the program more useful.
I will send you a letter of heartfelt thanks, since you have acknowledged my hard 

work.

Granted, it's not a lot of material stuff.    But, most of my customers just want to tell me 
thanks, and I think that is what Shareware buyers are all about.



When you register WinGO!, you will receive the following:

The latest version of the program.
A registration code to enable you to register future versions.
Full sound support, including voices and number calling.
The WinGO! GameMaker application, so you can design your own game groups.
Several new Game Groups.



This    is the Tallyboard.    This shows which numbers have been called out since the start of 
the current game.    It comes in handy when you fall behind and have enough time to check 
it for numbers you may need to call WinGO!    When a number becomes blue, it has been 
called.



This is the Message Line.    It contains three sections.    On the left is the current score of 
games won by each player.    In the middle is an information line.    Program status and hints
as well as random comments will appear here.    On the right is Rosie's game status.    It will 
tell you how close she is to calling WinGO!    When Rosie says that she is "Waiting on 1", this
means that one of her cards is one number from a WinGO! call.    When she says "Waiting 
on 3", this means that three different places on any of her cards is waiting for a number to 
make the call.    The higher this number gets, the closer she is to calling WinGO!



This button serves three purposes.    When you first enter WinGO!, it will read Start.    When 
you press it, the game will begin and it will change to read Pause.    Now this is where self-
control comes in.    It is considered cheating if you press this button to stop the game so you
can catch up.    The Pause control is meant for stopping the game for phone calls and such.  
Anyway, if you do press it, the game pauses and the button will read Resume.    Pressing it 
in this state restarts the game from where you left off.



This button is the WinGO! button.    Press it when you think you have a winning card.    The 
program will evaluate your cards for a winner, and show the first winning card it finds with 
the winning combination shown in raised letters (when there is a possibility of several 
combinations, such as in a vertical game).    Notice that the card shown may not be the one 
you thought was the winner!    It is possible that you may have more than one winner 
without knowing it.

If WinGO! finds that you do not have a winner, you will be returned to the game.    If this 
happens three times in one game, the WinGO! button will become disabled.    Of course you
will no longer be able to win that particular game.



This is the Game Type Indicator.    This icon will graphically depict the type of game being 
played by giving examples of winning patterns for the current game.



This is the Game Timer.    While the game is running, the timer will measure the length of 
the game.    When someone wins, that time will be measured against the times for other 
games recorded in the High Scores menu.    If the time is better than any of them it will be 
placed in the menu and stored along with the player's name, the date and what level was 
being played.



This is the Current Number Indicator.    It will be updated at a rate which depends on the 
game speed you have selected.    The numbers are of a large font size so you can see them 
easily.    However, since most players are concentrating on their Game Cards, it is possible 
to miss when this number changes.    To help avoid this situation, a beeper option is 
available.    If selected, (see Using the Options Menu) a beep will sound each time the 
number changes.    This will draw your attention to the Current Number Indicator.    The 
pitch of the beep gets higher with each number change, to provide a feeling for how far the
game has progressed.



This is a drop down combobox that allows you to select the particular game that you wish 
to see high scores for.    When you change it, the Scores list box will display the list of high 
scores for that game.



This is a listbox that contains the top ten high scores (or lowest times) for the game that 
currently displayed in the combobox above.



Press this button to close the High Scores Dialog.



Use this button to clear the High Score list for the game that is shown in the combobox 
above.    You will be prompted for confirmation before the list is actually cleared.




